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DMP30 / DMP40 Safety

1 Safety

► Refer to the safety information before starting-up this gauge in order to avoid 
damage to property or personal injury.

► Keep this manual in a safe place to be able to refer to any necessary descrip-
tions at a later date.

1.1 Warnings and icons used

ATTENTION

Indicates a danger that can lead to damage or destruction of the product.

CAUTION 

Indicates a low-risk danger that could result in minor or moderate 
injuries or damage to property if not avoided.

WARNING 

Indicates a medium-risk danger, which could result in death or 
serious injuries if not avoided.

DANGER 

Indicates a high-risk danger, which could instantly result in death 
or serious injuries if not avoided.

NOTE

Indicates helpful information, tips and notes

Page reference

Indicates references to further descriptions
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1.2 Intended use

The gauge is intended solely for the measurement of coating thicknesses.

The measurement system (gauge and probe) is designed for operation under the fol-
lowing environmental conditions:

 Indoor and outdoor operation

 Operation outside potentially explosive areas only!

 Ambient temperature during operation: 0 … +40 °C (+32 °F … +104 °F)

 Operation at altitudes up to 2000 m (6561.7 ft) above sea level

Only accessories approved or recommended by the manufacturer may be connected 
to the gauge.

Any further use is not in accordance with the intended use. The risk of damage re-
sulting from this is borne solely by the user!

ATTENTION – Destruction of the gauge due to condensation

If the gauge is moved from a cold environment to a warm environment, conden-
sation can form inside the gauge and damage its electronics. Such extreme 
temperature changes occur e.g. in winter between outside (0 °C (+32 °F)) and 
room temperature (+22 °C (+71.6 °F)).

► Allow the gauge some time to acclimatize to the ambient temperature 
before turning it on and starting a measurement.

1.3 Safety of the electrical equipment

EMC (Directive 2014/30/EU, electromagnetic compatibility)

The gauges of the DMP series comply with the regulations concerning electromag-
netic compatibility. The gauges are designed for battery operation. Mains operation 
via travel charger or PC is possible, but not recommended. The guaranteed confor-
mity applies exclusively to battery operation!
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ATTENTION – Damage due to high temperature

When exposed to sunshine, the areas behind glass windows (e.g. in a car) can 
easily reach temperatures in excess of +50 °C (+122 °F). This can cause 
damage to the gauge. 
Do not keep or store the gauge and accessories behind glass panes, or near to 
heat sources such as radiators etc.!

ATTENTION – No data transfer due to damaged connection and interconnec-
tion cables

Kinking or pinching of the connecting or interconnecting cable will result in line 
breakage. Excessive pulling force can cause the cable to tear out of its connec-
tion. In all these cases, data transfer (measurement signal) is no longer 
possible.

► Always connect an undamaged cable to the gauge. USB: max. length 3 m 
(118.1 ")

► Store the cable only in coiled condition, coiling radius ≥ 20 mm (0.79 ").

► Do not  use the probe and connection cable as a carrying aid!

ATTENTION – Wrong line voltage when charging the battery

An incorrect line voltage can lead to damage or destruction of the USB charger.

► Check the specifications for the line voltage before plugging the USB 
charger into the socket. The local line voltage must match the line voltage 
specified on the type plate of the USB charger.

CAUTION – when handling the battery

Improper handling of the battery can cause the battery to overheat, 
leak or burst.

► Use only batteries specified by the manufacturer to operate 
this gauge:
Type RRC 1130 (3.8 V, 14.47 Wh, scope of supply)

► Prevent metal objects such as necklaces, rings, etc. from 
short-circuiting the contacts. 
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► Do not continue to use the battery if you notice any changes 
such as discoloration, deformation or damage to the outer 
casing.

► Replace the battery if it is not charged after the usual charging 
time. The usual charging time can be found in the technical 
data.

► Do not expose the battery to excessive heat, moisture or direct 
contact with water. 

► Store the gauge without  the battery when not in use for a long 
period of time.

1.4 Maintenance and repairs

Modifications, repairs, as well as maintenance and service work on the gauge and 
accessories may be carried out only by service personnel authorized by the manu-
facturer.

Exception: changing the batteries/rechargeable batteries

1.5 Disposal

Do not dispose of old electronic devices and electronic accessories with house-
hold refuse!

► Follow the instructions in your region on the proper disposal of old elec-
tronic devices and electronic accessories!

► Dispose of damaged or defective old devices and accessories in the desig-
nated collection containers!

Do not dispose of rechargeable batteries and batteries with household refuse!

► Follow the instructions in your region on the proper disposal of recharge-
able batteries and batteries!

► Dispose of damaged or used rechargeable batteries and batteries in the 
designated collection containers!
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2 Limitation of liability

The manufacturer accepts no liability and no responsibility for the precision, conclu-
sions, and interpretation of the measurement results. Only continuous monitoring of 
the measurement devices by the user can guarantee the continued precision of mea-
surements. The manufacturer accepts no liability or responsibility for consequential 
damage caused by the use of incorrect measured readings.

3 Description

The gauges of the DMP series measure coating thicknesses easily, quickly, and in a 
nondestructive manner. The gauge design with exchangeable probes allows a flexi-
ble use.

This Operator's Manual describes the following gauge models of the DMP series:

 DUALSCOPE® DMP40
Coating thickness measurement on ferrous as well as on non-ferrous metal 
base materials (NC/FE, NF/FE, NC/NF)

 DELTASCOPE® DMP30
Coating thickness measurement on non-ferrous base materials (NC/FE, 
NF/FE)

 ISOSCOPE® DMP30
Coating thickness measurement on non-ferrous base materials (NC/FE)

Additional information can be found in the data sheet, from page 17



6 Description  DMP30 / DMP40

3.1 Scope of supply

 Gauge

 Li-ion battery

 USB cable type C to type A, 1 m (39.4 ")

 Safety information and quick guide

 Gauge case

 Fischer-Bluetooth stick

3.2 Gauge

1 Battery compartment lid, Bluetooth in-
terface

2 Light strip for displaying the mea-
sured reading acquisition, specifica-
tion limit violation, battery charge 
status

3 Display

4 Operation keys,
: on/off (press for approx. 2 s) 
: opens the menu when  is not 

shown in the bottom line of the display
: navigation and selection keys

The bottom line of the display always shows the function for the keys directly underneath. 
The assignment depends on the open page view in the display (example).

5 Gauge foot

6 Probe connection and battery fast charging plug, USB type C

7 USB port, type C, under the sealing tab of the battery cover

8 Shock protection

Gauge dimensions and further properties, see data sheet, from page 17

1

2

3

4

5
6

7

8

8

[   ]

[   ]

OK
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Setting values faster

• Measure once on the surface. You can use this value to set the desired value 
faster.

• Press and hold the arrow keys  or  longer.

3.3 Overview of signals

If all signal functions in the gauge are activated, the gauge reports the following 
states:

Beeps

 Short beep = measured reading acquisition complete, second beep in addition 
if the specification limit is violated

 Long beep = block closure 

Light signals

 Specification limit monitoring not active: 
Green = measured reading acquisition successful

 Specification limit monitoring active: 
Red = measured reading outside the specification limits, the measured reading 

itself is also displayed in red.
Green = last measured reading is within the specification limits

Gauge vibration

 Measured reading acquisition completed, second vibration in addition in case of 
a specification limit violation or block closure

3.4 Softkey – icons/codes

Forward, skips the next step in the routine

Back

• Returns to the previous menu page, displayed settings are applied

• Moves the cursor to the left, e.g. when the name is entered

Opens the Measurement view
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Calls up the calibration (calibration routine) from the Measurement view

Moves the cursor using the arrow keys

• Moves the selection marking

• Increases/decreases the numerical value displayed

Calls up the Delete function

Opens another menu page

Scrolls, displays the next page

Run

• Confirm the message/information

• Starts the function (e.g. Delete function)

Cancels the setting process and exits the function or returns to the previous 
page without saving any changes

CLOSE Sets a block closure when the block statistics are exited; available only 
when automatic formation is deactivated

BLOCK Calls up the block statistics for the current measured reading block

OK Confirm

• Confirms the selection/setting/information

• Moves the cursor to the right, e.g. when entering a name

RUN Starts continuous count rate acquisition

STD Calls up the page for entering the nominal value of the calibration foil/cali-
bration standard used

STOP Ends the continuous count rate acquisition

TH Switches to coating thickness display in the count rate Measurement view 
(unit of measurement set as in the open batch)

XN Switches to count rate display in the count rate Measurement view
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3.5 Measurement view

1 Currently measured coating/base 
material combination, NF/FE or NC/
NF

2 Batch name

3 Specification limits

4 Reading currently being measured

5 Statistical values

6 Key assignment line (example: delete 
function, block statistics, calibration 
function)

7 Status displays; icons indicate active 
autom. gauge shutdown (clock), bat-
tery charge status or the active con-
nection via USB or Bluetooth for 
example.

8 Information displays; icons indicate block closure, set measuring mode, offset, 
etc.

9 Unit of measurement

3.6 Display icons/codes

Statistics menu, contains statistical evaluations and displays for the open batch.

Batch Modify menu, contains a list of alterable batch settings

Batches menu, contains a list of batches already created, the New function, for 
creating a new batch and the management function for batches already creat-
ed: Rename, Copy and Delete

Calibrations menu, contains a list of calibrations already created, the New func-
tion for creating a new calibration and special functions for calibrations already 
created, e.g. Rename, Shortened course and Delete

Gauge Settings menu, contains a list of alterable gauge settings 

NF/FE
Batch 001

No. 1 n 10

46.8 s 1.81

Min 44.9 Max 48.5

x

47.3 µm
 44.5

BLOCK

 49.0

Example of the Measurement 
view showing statistics with 
set specification limits

1
2

3

4

3

5

6

7
8

9
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Indicates additional information

Indicates warnings

Displays the currently measured coating/base material combination: non-fer-
rous coating material on ferrous base material; display only with the DELTA-
SCOPE® and DUALSCOPE® gauge models

Displays the currently measured coating/base material combination: electri-
cally non-conductive and non-ferrous coating material on electrically conduc-
tive non-ferrous metals; display only with the ISOSCOPE® and DUALSCOPE® 
gauge models

Battery status indicator: fully charged

Battery status indicator: replace battery soon 

If the battery voltage is too low, the gauge switches off automatically, measured 
readings and settings are retained

Energy-saving function, display dimming active

A period of time for at least one of the energy-saving functions is set.

USB connection active, gauge is connected to a PC via USB, for example

White icon: Bluetooth function is activated in the gauge

Blue icon: active Bluetooth connection, e.g. to a PC 

Red icon: the gauge cannot communicate with the inserted Bluetooth stick. In-
sert the Fischer-Bluetooth stick.

Gray icon: the socket in the gauge for the Fischer-Bluetooth stick is empty, but 
the Bluetooth function is switched on.

Free Running measuring mode active

Unlimited, Limited Number or Limited Number Block scan mode is active, de-
scription of scan modes 41

NF/FE

NC/NF
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Counted Average scan mode active
Measured reading acquisition until the probe is lifted off, storage of the arith-
metic mean over the acquired measured readings

Indicates a block closure, appears with the last measured reading of the block

Offset function is active

The automatic storing of measured readings is deactivated

On/Off switch, – parameter/function is activated

On/Off switch, – parameter/function is deactivated

Parameter selection – parameter/function is activated

Parameter selection – parameter/function is deactivated

No. Number of the current block

n Number of measured readings

• Number of measured readings in the current/selected block

• Number of all measured readings in the current batch

Arithmetic mean of the current block with n measured readings

s Standard deviation for the arithmetic mean ; a measure for the variation 
of individual measured readings (of a batch or block) around their common 
mean value.

Min Lowest measured reading within a block

Max Highest measured reading within a block

R The range equals the difference between the highest and lowest measured 
reading in a block or batch

O

x

x
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V[%] Coefficient of variation, percentage variation of a series of measurements, 
standard deviation in terms of the mean value , a sudden change in the 
coefficient of variation indicates a change in process conditions

n<USL Number of measured readings per block or batch below the lower specifi-
cation limit

n>OGW Number of measured readings per block or batch above the upper specifi-
cation limit

Characteristic variables occurring during the control measurement for check-
ing a selected calibration: a description of the characteristic variables can be 
found on page 69

3.7 Menus – function overview

Menu Statistics

View of the statistics for the open batch

Batch Modify menu

Settings and entries for the open batch

 Batch Modify > MEASURE
Opens the Measurement view, starts the measurement with the probe posi-
tioned on the specimen surface

 Batch Modify > Limits
Activates limit monitoring and sets the specification limits

 Batch Modify > Batch Info
Information on the measurement and batch settings

 Batch Modify > Views Settings

• Measurement view: selects the display

• Batch statistical display: selects the statistical characteristic variables to be 
displayed

• Block statistical display: selects the statistical characteristic variables to be 
displayed

x
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 Batch Modify > Meas. unit
Sets the unit of measurement

 Batch Modify > Block Size
Activates automatic block formation and set the block size

 Batch Modify > Offset
Sets the offset value

 Batch Modify > More Settings > Measure Mode
Sets a measuring mode (single reading, free-running, , scan)

 Batch Modify > More Settings > Values rounding
Sets the number of decimal places for the values displayed

 Batch Modify > More Settings > Save Readings
Saves measured readings (yes/no)

 Batch Modify > More Settings > Air Reference
Sets the acquisition method for the air reference value

 Batch Modify > More Settings > Calibration Assign
Assigns a different calibration

Menu Batches

 Batches > New, starts a routine for creating a new batch in the gauge.

 Batches > List containing the batches stored in the gauge;
After a batch has been selected, it can be opened, renamed, copied, or deleted.

Menu Calibrations

 Calibrations > New, starts a routine for creating a new calibration in the con-
nected probe.

 Calibrations > List containing the calibrations stored in the connected probe;
After a calibration has been selected, the following functions are available:

• CALIBRATE
Starts the calibration routine for the selected calibration

• Rename
Renames the selected calibration

• Def. Cal. Check
Defines test settings for checking the selected calibration
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• Check Calibration
Starts the checking procedure for the selected calibration

• Lock Calibration
Locks the selected calibration, possible only with a pre-defined lock code

• Shortened course
Activates a semi-automatic calibration routine

• Reset
Deletes all coating thickness correction values from the selected calibration

• Delete
Deletes the selected calibration from the probe memory

• Info
Displays information about the selected calibration

Gauge Settings menu

 Gauge Settings > Language
Selects the display language

 Gauge Settings > Display Settings
Activates/deactivates display flip function and display brightness

 Gauge Settings > Signal Settings

• Audible signal on/off

• Activates/deactivates the visual signals and sets the luminosity

• Vibration on/off

 Gauge Settings > Data Transfer
Data transfer via Bluetooth on/off; 
NOTE: A data transfer via USB and Bluetooth is possible only for evaluation pur-
poses using Tactile Suite archiving software.

 Gauge Settings > Energy Savings
Activates automatic gauge shutdown and display dimming after a preset period 
of time

 Gauge Settings > Date & Time
Sets the date and time, and also the date and time format

 Gauge Settings > More Settings

• Preset Unit
Unit of measurement, default for creating the batch
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• Preset rounding
Number of decimal places for the values displayed, default for creating the 
batch

• Define Lock Code/Delete Lock Code
Activates/deactivates the lock code for locking the calibration

 Gauge Settings > Probe - Menu

• Probe Raw Values
Test menu with display of probe raw data 

• Set Power Line Frequency (not for gauge models ISOSCOPE®)
Adjusting the frequency of the local voltage supply to compensate for the 
interference radiation emanating from the local voltage supply increases 
the measuring performance for the DUALSCOPE® and DELTASCOPE® gauge 
models

• Delete all calibrations
Deletes all calibrations from the memory of the connected probe; NOTE: You 
cannot measure without a calibration!

 Gauge Settings > About
Information about the firmware version, copyright and connected probe

3.8 Statistical characteristic variables

 – Mean Value
Arithmetic mean value ( ) of all measured readings. The arithmetic mean value is 
the summation of all measured readings xi of a batch or block, divided by the num-
ber of measured readings (n).

n – Number
Number of all measured readings in a batch or per block.

s – Std. Dev.
Standard deviation is a measure for the variation of individual measured readings (of 
a batch or block) around their common mean value ( ). It equals the mean square 
deviation of the measured readings from the mean value.

R – Range
The range equals the difference between the highest and lowest measured reading 
in a batch or block.

V[%] – Coeff. of Variation
Coefficient of variation, percentage variation of a series of measurements, i.e. stan-

x
x

x
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dard deviation (s) relative to the mean value ( ). The coefficient of variation is a char-
acteristic process constant. A sudden change in the coefficient of variation indicates 
a change in process conditions.

Min – Low. Value
Lowest measured reading in a batch or block.

Max  – High. Value
Highest measured reading in a batch or block.

<LSL – n < LSL
Number of measured readings below the lower specification limit (LSL).

>USL – n < LSL
Number of measured readings above the upper specification limit (USL).

No. – Block No. (No.)
Number of the current/selected measured reading block.

x
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3.9 Technical Data

Description

With these gauge models you measure coating thicknesses easily, quickly, non-
destructively and with the precision that is typical for all Fischer instruments.

This gauge family contains gauges for measurement on ferrous, electrically con-
ductive base material, or both base material models. 

Universally

 Universal applicable coating thickness gauges

 Various probe models are connectable to the gauges, appropriate to your indi-
vidual applications;
Measurement range, trueness and repeatability are dependent on the connect-
ed probe. You will find this data in the respective probe data sheet.

 Uniform, simple and convenient operation

 Calibrations for various applications are storable in and recallable from the 
connected probe

 USB and Bluetooth® interface

 Compact and robust aluminium case with protection type IP64

 Battery rechargeable in the gauge or by a separate charger

Models

DELTASCOPE 
DMP30

ISOSCOPE 
DMP30

DUALSCOPE 
DMP40

SR-SCOPE 
DMP30

Convenience models with large data 
storage and expanded feature range as 
more measurement value storage, 
grouping measured readings, limit 
monitoring, measurement mode Scan 
and Bluetooth® interface
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Applications

Metrological Features

Measurement acquisition

 Default: After each placement of the probe onto the surface, a measured read-
ing is automatically recorded

 Scan mode: While probe is moving over the surface the measured readings are 
automatically recorded according to the defined time interval and number of 
measurements.

Indication of measurement acquisition

 Audible by a short beep, can be disabled

 Visual by colored illuminated strip (green: measured value recorded)

 Haptic feedback by gauge vibration, can be disabled

 Limit violation: 2 short beeps, red illuminated strip and gauge vibration

 Measured reading between the limits: 1 short beep, green illuminated strip and 
gauge vibration

Measurement performance
Measurement speed, measurement range, trueness etc. depend on connected 
probe, you will find these data in the respective probe data sheet

DELTASCOPE 
DMP30

ISOSCOPE 
DMP30

DUALSCOPE 
DMP40

SR-SCOPE 
DMP30

 

 

Examples

Base material steel or iron (FE)

 Zn, Cr, Cu coating on steel or iron 
(NF/FE)

 Paint, varnish, plastic coating on 
steel or iron (NC/FE)

Base material electrically conductive (NF)

 Paint, varnish, plastic coating on 
Al, Cu or Brass (NC/NF)

 Anodized coating on Al (NC/NF)
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Grouping measured readings
Block (group) size can be set between 1 and 1000 single readings

Storage of measured readings
Can be disabled

Measurement unit
µm, mm, mils, µinch or customized unit (definable, related to µm), selectable

Limit Monitoring
Can be disabled; limit values can be set

Offset value/ correction value
Can be set, is deducted automatically from the measured reading. Thus, one ob-
tains the thickness of the top coating if for instance the interim coating is known.

Resolution of the displayed values

 Low (up to 1 decimal place)

 Medium (up to 2 decimal places)

 High (up to 3 decimal places)

 NAVSEA (1 decimal place for measured readings up to 254 µm (10 mils), inte-
ger for measured readings as from 254 µm (10 mils)

Measurement modes 

 Single Reading
After each placing of the probe, the measured reading is displayed and stored 
automatically in the gauge.

 Free Running
After placing the probe on the surface, the continuous display of the measured 
readings appears without automatic storage, useful for quick checking of coat-
ing thicknesses over a defined surface area, e.g. in tank construction

 Scan
The Scan mode allows a defined acquisition of the measured readings while 
the probe is moving over the surface. You can set the number of single read-
ings and the time interval for the measurement acquisition in the gauge. Useful 
to determine the coating thickness over surface areas.
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Calibration

For a correct measurement of the coating thickness, the gauge must detect the 
properties (permeability, electrical conductivity, geometry) of the test piece. This 
adjustment is carried out by a calibration. Furthermore, the gauge contains a 
function for semi-automatic calibration.

Calibration method
Adjustment of the measuring system (gauge and connected probe) to geometri-
cal form and base material of the test piece (= Zero point determination) and ad-
justment to up to two coating thickness values by using calibration foils. On reca-
libration, individual calibration steps can be skipped.

Store calibrations
The storage location for a calibration depends of the connected probe.

 Digital probe: up to 100 calibrations can be stored in the connected digital 
probe;
probe identifiable by the USB-C female jack and by the probe name, always be-
ginning with the letter D

 Analog probe: connection via DMP-F-probe-Adapter plugged into the gauge; a 
total of up to 100 calibrations can be stored in the DMP-F-Probe-Adapter; only 
the calibrations that were created with the probe connected to the DMP-F-
Probe-Adapter are available in the gauge in each case. 
Probe identifiable by the 10-pin male jack and by the probe name, always be-
ginning with the letter F or containing the letter F.

Calibration check
Checking the calibration state of the selected calibration and the measuring ac-
curacy of the measuring system. You can check whether the mean value of the 
check measurement matches the reference value of the calibration standard 
within the scope of measurement uncertainty (in accordance with ISO/IEC Guide 
98-3).

Lock calibrations
You can lock selected calibrations.
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Ways of air reference value acquisition
During measurement, the air reference value is used to reference the zero point 
determination. Regular measurement of the air reference value is necessary to 
achieve high measurement accuracy. This is done automatically in the measure-
ment mode Single Reading when the probe is lifted off from the surface.

 Default in Probe: air value acquisition as factory predefined in probe (Dynamic/
Static)

 Dynamic: automatic acceptance of the air value always when the probe is lifted 
from the surface, default mode

 Static: no automatic acceptance of the air value always when the probe is lifted 
from the surface. In this case, the air reference value must be measured man-
ually at regular intervals. This may be useful for measurements in small cavi-
ties or pipes where the minimum lift-off distance of the probe cannot be main-
tained within cavity/pipe.

General Features

Measurement views

 Simple: the measured reading with the set measurement unit is displayed only; 
additionally with display of the limit values if set

 Statistics: the measured reading with tabular measurement statistics 

Languages
Many different display languages, beside German and English several other Eu-
ropean and Asian languages

Date & Time

 settable

 Date and time formats settable (DD.MM.YY or MM/DD/YY and 12 h or 24 h)
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DELTASCOPE 
DMP30

ISOSCOPE 
DMP30

DUALSCOPE 
DMP40

SR-SCOPE 
DMP30

≤ 2500

≤ 250000

≤ 10000

≤ 10000

Storage space

Number of batches

Total number of measured readings

Number of blocks per batch

Number of meas. readings per block

DELTASCOPE 
DMP30

ISOSCOPE 
DMP30

DUALSCOPE 
DMP40

SR-SCOPE 
DMP30

   

   

   

Evaluation

Batch statistics 

Evaluation of all stored measured 
readings of one batch

Block statistics

Evaluation over the grouped mea-
sured readings, evaluation per block

Graphical presentation of measured 
readings

Histogram of all measured readings 
of one batch, from 5 readings

DELTASCOPE 
DMP30

ISOSCOPE 
DMP30

DUALSCOPE 
DMP40

SR-SCOPE 
DMP30

   

   

   

   

   

Data transmission

via USB

via Bluetooth®
only with Fischer Bluetooth® stick

Data export via Tactile Suite to 
Excel® (online, offline)

Data retrieval from Tactile Suite, 
batches, single readings, batch 
statistics, 

Block statistics 
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Connectable probes

 Digital probes with USB-C female jack, probe names always beginning with the 
letter D

 Via DMP-F-Probe-Adapter many analog probes with 10-pin male jack; probe 
names beginning with the letter F or containing the letter F; 

 Probes connectable to the DMP-F-Probe-Adapter: F20H, FA100, FA14, FA30, 
FA70, FA9, FAW3.3, FD10, FD13H, FGA0.6H FGAB1.3, FGAB1.3T, FGABW1.3, 
FGB2, FGBW2, FKB10, FKB4, FTA2.4-MC, FTA2.4-SC, FTA3.3, FTA3.3-5.6, 
FTA3.3-5.6-HF, FTA3.3F-Cr, FTA3.3FG, FTA3.3H, FTD3.3, V7FKB4

 Not supported probes: duplex probes (FDX10, FDX13H, FN4D) and special 
probes for special customer-specific applications

The Fischer probe program encompasses nearly 100 probes designed to ensure 
optimal results with highest accuracy for the widest range of measurement ap-
plications. At factory each individual probe is adjusted at several reference points 
with the greatest care to ensure the highest possible degree of trueness.

Energy management
 Power supply: Li-Ion rechargeable battery, model RRC1130

Nominal voltage: 3.8 V= 
Nominal capacity: 3880 mA, 14.7 Wh
max. charge voltage: 4.35 V=
max. charge current: 2.4 A

DELTASCOPE 
DMP30

ISOSCOPE 
DMP30

DUALSCOPE 
DMP40

SR-SCOPE 
DMP30

 

 

Test methods

DIN EN ISO 2178 / ASTM D7091 

Magnetic induction test method, 
measurement of non-magnetic coat-
ings on magnetic substrates

DIN EN ISO 2360 / ASTM D7091

Amplitude-sensitive eddy current 
test method, measurement of non-
conductive coatings on non-magnet-
ic substrate metals
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 Energy saving for longest battery life
 Automatic gauge switch-off after a preset time period w i t h o u t  operation 

(key use, data transfer or measurement acquisition)
 Automatic dimming of the display brightness after a preset time period

 Battery operating period
> 24 h with continuous measurement and about +20 °C (+68 °F) ambient tem-
perature

 Battery charging time
Temperature during charging: 0 … +45 °C (+32 … +113 °F)
about 6 h by default
about 3 h for fast charging

Protection class
IP64, dust-protected, splash-water proof

Admissible climatic conditions during storage and transport
We recommend to store and transport battery and gauge separately

 Gauge with/without Li-Ion rechargeable battery 

 Indoor only

 Ambient temperature: -20 … +60 °C (-4 … +140 °F)

 Relative humidity: 5 … 60 %RH at 20 °C (+68 °F), non-condensing

Admissible climatic conditions during operation

 Ambient temperature: 0 … +40 °C (+32 … +104 °F)

 Relative humidity: 5 … 85 %RH at 25 °C (+77 °F), non-condensing

 Altitude of location: up to 2000 m (6561.7 ft) (above sea level)

 Pollution degree: 3

Visual indications

 Graphical display with automatic flip view (can be disabled) allows optimum 
reading in different measuring positions

 Colored illumination strip to signal measurement acquisition, limit violation 
and battery charging status
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Connections

 2 USB female jacks, type C

 USB 3.1, 900 mA/5 V=, at gauge bottom: for connecting digital Fischer probe 
 for fast charging the Li-Ion rechargeable battery in the gauge

 USB 3.1, 500 mA/5 V=, at gauge top: for charging the Li-Ion rechargeable 
battery in the gauge  for connection to a PC for data transfer  max. cable 
length: 3 m (118 ")

 USB socket, type A, at gauge top

 Specific for inserting Fischer Bluetooth® stick for data transfer via Blue-
tooth®
Fischer Bluetooth® stick (scope of supply): Bluetooth v 4.0. LE, transmit pow-
er up to -27 dBm

Weight
Gauge with rechargeable battery: 276 g (0.61 lb)

Dimensions

Scope of supply
Gauge, Li-Ion rechargeable battery, USB cable type C to type A (1,5 m/59.06 "), 
safety information and quick guide, lanyard, gauge case, Fischer Bluetooth® stick

28 mm
1.10 "

70 mm / 2.76 "

38 mm
1,50 "

50
m

m
1.

97
"

12
9

m
m

 /
 5

.0
8

"
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Order Information
  

  

DELTASCOPE 
DMP30

ISOSCOPE 
DMP30

DUALSCOPE 
DMP40

SR-SCOPE 
DMP30

1007331 1007332 1007333 1007335

≤ 2500

≤ 250000 measured readings

   

   

   

Gauge model

Order number

Number of batches

Storage capacity

Vibration function

Grouping of measured readings

Bluetooth® interface

DUALSCOPE 
DMP20

DELTASCOPE 
DMP30

ISOSCOPE 
DMP30

DUALSCOPE 
DMP40

SR-SCOPE 
DMP30

in conjunction with probe 
only, see probe data sheet

free of charge download, you 
will find download link in 

guide and manual on 
page 78

1007336

1008201

1008215

- 1008864

1008303

1008304

1005837

1007162

Accessories/Spare parts

Manufacturer’s Certificate M ac-
cording to DIN 55350-18

Evaluation and archiving software 
Tactile Suite

DMP-F-Probe-Adapter for connect-
ing analog probes with 10-pin con-
nection plug

Gauge support stand

USB C cable, type C to A, 1 m (39.4 ")

Fischer Bluetooth® stick

Bluetooth v 4.0. LE, transmit power 
up to -27 dBm

Li-Ion rechargeable battery
model RRC1130

Charger for battery model RRC1130

Gauge foot

Battery compartment cap
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You must order the probe separately. Choose the right probe for your individual ap-
plication from our comprehensive probe portfolio. Call us, we are gladly support you 
with the selection.
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4 Guide

All relevant settings for measuring the coating thick-
ness of a coated specimen1 and the measured read-
ings themselves are saved in the gauge in a file. 
Such a file is called a batch. In order to measure, you 
must assign to the batch a calibration (reference) 
that is saved in the connected probe.

In the batch, you define the measurement procedure, 
e.g. whether specification limits are to be monitored 
during the measurement or whether the measured 
readings are to be acquired in measured reading 
block groups. 

3 steps to the measurement

1. Start-up the gauge

• Insert/charge the battery, 29

• Connect the probe, 33

• Switch on the gauge: press the [ ] key for 
approx. 2 s.

2. Open a batch or create a new one

• Open a batch:  > Batches > OK > select the 
desired batch from the batch list > OK

• Create a new batch, 37

3. Take measurements on the specimen, 46

If the specified precision is not achieved during 
the measurement, you must check the calibration, 68.

1. In this Operator's Manual, both a coated part of any shape and size and a surface containing mul-
tiple measuring positions are referred to as a specimen.

NF/FE
Batch 001

No. 110 n 10

46.8 s 1.81

Min 44.9 Max 48.5

x

BLOCK

47.3 µm

i49.0

i44.5

Example of the Measurement 
view showing statistics with 
set specification limits

 OK

Statistics

Batch Modify

Batches

Calibrations

Gauge Settings

NF/FE
Batch 001

Main menu (example: Batch 
001 is open)

[   ]
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5 Rechargeable battery

This chapter contains important instructions on handling, changing and charging the 
battery.

CAUTION – when handling the battery

Improper handling of the battery can cause the battery to overheat, 
leak or burst.

► Use only batteries specified by the manufacturer to operate 
this gauge:
Type RRC 1130 (3.8 V, 14.47 Wh, scope of supply)

► Prevent metal objects such as necklaces, rings, etc. from 
short-circuiting the contacts. 

► Do not continue to use the battery if you notice any changes 
such as discoloration, deformation or damage to the outer 
casing.

► Replace the battery if it is not charged after the usual charging 
time. The usual charging time can be found in the technical 
data.

► Do not expose the battery to excessive heat, moisture or direct 
contact with water. 

► Store the gauge without  the battery when not in use for a long 
period of time.

5.1 Changing the battery

Before you start

 The gauge is switched off ([ ]).
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To change the battery

   

  

  

What you can do next

 Charge the battery using the charger (available from Fischer as an accessory) 
for battery type RRC 1130

 Continue the measurement

 Make settings for the measurement; for an overview, see page 37

1. 2. 3.

4. 5. 6.

Make sure the 
battery is the 

right way round!

7. 8. 9. 10.
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5.2 Charging the battery

ATTENTION –Make sure the charging power is correct

Whether you use a standard travel charger or an external charger, always make that 
the battery is charged to the correct power:

Nominal voltage: 3.8 V=
Nominal capacity: 3880 mA, 14.7 Wh
max. charge voltage: 4.35 V=
max. charge current: 2.4 A

To charge the battery

 Standard – charge the battery using a commercially available charger: 

► Do this by inserting the USB-C plug of the charging cable on the top of the 
gauge into the USB-C socket under the locking tab. 
Battery charging time is approx. 6 h. A green light strip on the switched-off 
gauge signals the end of the charging process. 

  

1. 2.

Light strip

USC-C plug of 
charging cable
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 Alternative 1 – quick charging using a commercially available travel charger:

► Insert the USB-C plug of the charging cable into the USB-C socket on the 
underside of the gauge (probe connection). 
Battery charging time is approx. 3 h, a green light strip on the switched-off 
gauge signals the end of the charging process

 Alternative 2 – charge the battery using an external charger for model 
RRC1130 (available from Fischer as an accessory). 

a Switch off the gauge, .
b Remove the battery from the gauge, 29.
c Refer to the safety Information on page 29.
d Place the battery in the external charger.

Instructions for handling the external charger can be found in the Operator's 
Manual concerned.

1. 2.
USB-C plug of charging cable

[   ]
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6 Connecting/replacing probe

Every probe has its own identifier, consisting of a probe code (e.g. D-FN) and the se-
rial number. Each time a batch (measuring application, application) is created, the 
probe identifier is automatically saved as well. This ensures that for the open batch, 
a measurement can be performed only using the probe that has the same identifier 
as the one saved in the open batch. As a result, the correct calibration is available 
for the batch and for the measurement.

What would you like to do?

 Connect a new probe as a replacement for a defective one: proceed as de-
scribed in chapter "Replacing the probe – connecting a different probe", 35.

 Connect a different probe type to the one previously used: proceed as described 
in chapter "Replacing the probe – connecting a different probe", 35.

 Connect a new probe not yet used to create a batch in the gauge: 

a Connect the probe as described in chapter "Connecting the probe", page 33.

b Create a new batch, proceed as described in 37

 Connect a probe already used to create one or multiple batches in the gauge:

a Connect the probe as described in chapter "Connecting the probe", page 33.

b Open the desired batch, proceed as described in 38

6.1 Connecting the probe

Notes on safe secure measurement signal transfer

 Always tighten the knurled nut on the probe cable connector firmly to ensure 
a secure plug connection!

 We guarantee flawless measurement signal transmission from the probe to 
the gauge for a cable length of max. 3 m (118.1 ").

 Extending the probe cable to 3 m (118.1 ") using a USB-C extension cable is 
not  permitted, as the additional plug connection could impair the signal 
transmission.
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Before you start

 The gauge is switched off ([ ]).

To connect the probe to the gauge

 Digital probes (D…) with USB-C connecting socket, USB-C connection cable in-
cluded in the scope of supply

 Analog probes (F…) with 12-pin connecting plug via DMP-F probe adapter 
(1007336, available from Fischer as an accessory)

• To attach the DMP-F probe adapter to the gauge.

• To connect the probe to the DMP-F probe adapter..

Probe

2.1. 3. 4.

1. 2. 3. 4.

DMP-F probe adapter

Probe 
connector

DMP-F probe adapter

1. 2.
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6.2 Replacing the probe – connecting a different probe

You can replace a defective probe with a new probe of the same type or connect a 
different probe type to the one previously used.

ATTENTION – Data loss

If a new probe is assigned to a batch, all previous measured readings of the 
batch will be lost since the measured readings previously stored in the batch 
were measured using a different probe and a different calibration.

For data backup, save the batch or the previous measured readings of the 
batch in Tactile Suite, the link for download and further information can 
be found on page 78.

Refer to the following notes whenever you want to replace a defective probe

 You cannot  transfer the calibrations from the old, defective probe to the new 
replacement probe.

 With the new probe, you must perform the required calibrations and store them 
in the probe. This requires the new probe to be assigned once to the open batch. 
You can create the calibrations you need in the calibration menu and save them 
in the new probe.

 You must assign the new probe to all batches created using the old, defective 
probe, as well as the corresponding calibrations from the new probe.

 If the probe connected to the DMP-F-Probe-Adapter is a replacement, we rec-
ommend deleting all calibrations from the old, defective probe from the DMP-
F probe adapter before assigning the new replacement probe. This prevents 
the unusable calibrations from the old, defective probe unnecessarily taking up 
memory space in the DMP-F-Probe-Adapter, , delete all calibrations from the 
probe, see page 74.

Before you start

 The gauge has been switched off ([ ]) and a batch created with the old (defec-
tive) probe was opened beforehand.

To assign the connected probe to the open batch

1. Connect the new probe to the gauge, 33.

2. Switch on the gauge: [ ].
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3. Open the most recently opened batch: .

4. The Reassign probe? menu page appears.

The menu page displays the probe identifiers of the two probes: the old one 
previously assigned to the batch, and the connected new probe.

5. Assign the connected probe to the batch: OK.

A message tells you that a calibration still needs to be assigned to the open 
batch.

6. What would you like to do? 

• Assign a calibration from the connected probe to the open batch:  > 
select desired calibration > OK.
This completes the process and the Measurement view of the open batch 
appears.

• Perform a new calibration for the open batch:  > New > follow the cali-
bration routine, for the procedure, see page 66.
This completes the process and the Measurement view of the open batch 
appears.

• Do not  assign a calibration to the open batch: OK
This completes the process and the main menu appears.

Please note that a measurement is possible only if a calibration has 
been assigned to the batch.
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7 Settings for measurement

In order to measure, you need to create and open a batch (measuring file). Settings, 
such as those for the measurement procedure are saved in the batch, e.g. specifica-
tion limit monitoring and grouping of measured readings in measurement blocks 
during the measurement and in measuring mode. The link to the calibration to which 
the measurements are referenced is also stored in the batch file.

If any parameter changes, there is a new measuring application and you have to cre-
ate a new batch.

  A description of the possible batch settings you have to make before a mea-
surement can be found below.

 A description of the batch settings, which you can also make after a mea-
surement, can be found from page 82. 

7.1 Creating a new batch

You can create a batch in the following ways:

Create a new batch from scratch

In this case, you must make all the required measurement settings again.

1.  > Batches > OK > New > Select a calibration from the list or New from > OK 

2. Have you selected a calibration from the list?

• No: Continue with step 3.

• Yes: Continue with step 4.

3. Follow the calibration routine and finish each calibration step via OK. You can also 
skip the last calibration step (Std. 2) via , 62.

4. Make the desired batch settings for the measurement  38, assign a batch 
name, 88

This completes the creation process for a new batch.

5. Call up the Measurement view for the new batch: MEASURE > OK.

[   ]
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Creating a new batch by copying

You use the Copy function to create a batch by copying a selected batch. Apart from 
the measured readings and the batch name, the batch copy contains all the settings 
of the batch copy template.

►  > Batches > OK >select a batch as a copy template from the list> OK > Copy 
> OK > The Measurement view of the newly created batch appears in the display

 Measurement settings, see from page 38
 Assign calibration, see page 44
 Check calibration, see page 68
 Rename a batch, see page 88

7.2 Opening a batch

►  > Batches > OK > select desired batch from the batch list > OK
The Measurement view of the selected batch appears in the display.

 Measure, see from page 46
 Check calibration, see page 68

7.3 Activating/deactivating specification limit monitoring

Before you start

 The batch for which you want to make the changes is open in the gauge.

To activate specification limit monitoring and set the specification 
limits 

1. Select the specification limits to be monitored:  > Batch Modify > OK > Limits 
> OK > select desired specification limit parameter > OK.
Parameter is activated: 

The selected specification limit(s) with the currently set values appear in the 
specification limit menu.

[   ]

[   ]

[   ]
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2. Set the specification limit: select specification limit > OK > set desired value > 
OK.

Repeat step 2 for the second specification limit, provided you have selected 
Both in step 1.

3. Exit the menu: , the settings are now made

In the Measurement view, lines with the entered specification limits appear 
above and below the measured reading or a line appears below the measured 
reading with the entered limit value.

To deactivate specification limit monitoring

1.  > Batch Modify > OK > Limits > OK > Off > OK
Parameter is activated: 

2. Exit the menu: , specification limit monitoring is deactivated.

7.4 Activating/deactivating automatic block formation

You can automatically group a predefined number of measured readings into mea-
sured reading blocks. Activate automatic block formation to form a block closure au-
tomatically after a specified number of measured readings during the measurement.

Before you start

 The batch for which you want to make the changes is open in the gauge.

 The open batch does not contain any measured readings.

To activate automatic block formation and set the desired block size

1.  > Batch Modify > OK > Block Size > OK > Generate autom. > OK.
Parameter is activated: 

2. Set the block size: Block Size > OK > set desired value > OK.

3. Exit the menu: , the settings are now made.

[   ]

[   ]
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To deactivate automatic block formation

1.  > Batch Modify > OK > Block Size > OK > Generate autom. > OK.
Parameter is deactivated: 

2. Exit menu: , automatic block formation is deactivated.

7.5 Activating/deactivating offset function

You can correct the measured reading by a pre-defined offset value. The actual mea-
sured reading less the offset value is displayed.

Application example: coating thickness measurement on a 2-coating system with 
known intermediate coating thickness that is entered as the offset value. Only the 
thickness of the top coating is then displayed.

Before you start

 The batch for which you want to make the changes is open in the gauge.

To activate the offset and set the offset value 

1.  > Batch Modify > OK > Offset > OK > On > OK > set desired offset value > OK
Parameter is activated: 

2. Exit the menu: , the settings are now made.

The  icon appears in the Measurement view to indicate the active offset func-
tion.

To deactivate the offset function

1.  > Batch Modify > OK > Offset > OK > Off > OK
Parameter is deactivated: 

2. Exit the menu: , the offset function is deactivated.

[   ]

[   ]

O

[   ]
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7.6 Selecting measuring mode

You can specify how the measured readings are to be acquired and displayed.

Single Readings (default mode)
Measured reading acquisition after the probe is placed on the surface. The measured 
readings are automatically saved in the batch (measurement file), provided the Save 
Readings function is activated.

Free Running
Continuous measured reading display while the surface is being scanned with the 
probe. Measured readings are not saved even if the Save Readings function is acti-
vated!

Select Free Running measuring mode if you want only an overview of the coating 
thickness distribution.

Scan
Defined measured reading acquisition while the surface is being scanned with the 
probe. You can set the number of measured readings and the interval time for mea-
sured reading acquisition in the gauge. The measured readings are automatically 
saved in the batch (measurement file), provided the Save Readings function is acti-
vated.

 Unlimited
According to the time interval set in the Scan measuring mode menu, a mea-
sured reading is acquired and saved every x seconds as the surface is being 
scanned. Automatic measured reading acquisition is stopped by lifting off the 
probe. This function is not suited for non-stop operation, see also notes on 
page 46.

 Limited Number
According to the parameters (time interval, number of measured readings to be 
acquired) set in Scan measuring mode, a measured reading is acquired every x 
seconds as the surface is being scanned. After n measured readings, automatic 
measured reading acquisition stops. The measurement cycle is repeated when 
the probe is applied again.

 Counted Average
An arithmetical mean is formed from the individual measured readings contin-
uously acquired as the surface is being scanned, and this value is saved and 
used for the further evaluation. Automatic measured reading acquisition is 
stopped by lifting off the probe.

 Limited Number Block
Available only when automatic block formation is activated. According to the 



42 Settings for measurement  DMP30 / DMP40

parameter (time interval) set in Scan measuring mode, a measured reading is 
acquired every x seconds as the surface is being scanned. After n measured 
readings, automatic measured reading acquisition stops. The measurement cy-
cle is repeated when the probe is applied again. The setting for the number of 
measured readings per block in the Block Size is used as the number of mea-
sured readings.

Before you start

 The batch for which you want to make the changes is open in the gauge.

To select a measuring mode

1.  > Batch Modify > OK > More Settings > OK > Measure Mode > OK > select 
desired mode > OK
Parameter is activated: 

2. Have you selected the Scan measuring mode?

• No: continue with step 6.

• Yes: Continue with step 3.

3. Select the Scan Mode on the page with the same name: Scan Settings > OK > 
select the desired Scan Mode > OK 

Parameter is activated: 

4. Have you selected the Scan Mode Counted Average?

• No: continue with step 6.

• Yes: Continue with step 5.

5. Set the interval time and, if required, the number of measured readings: 
Interval time [s] > OK > set desired value > OK.

Repeat step 5. for the Number of Readings parameter, provided you have 
selected 3. Limited Number in step.

6. Exit the menu: , the settings are now made.

In the Measurement view, depending on the measuring mode selected, the cor-
responding icon appears to indicate the active function, a description of the 
icons can be found on 9.

[   ]
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7.7 Save measured readings on/off

You can specify whether the measured readings are automatically saved in the open 
batch.

Function activated (default mode)
The measured reading is automatically saved in the open batch with every measured 
reading acquisition.

Function deactivated
The measured readings are automatically saved in the open batch only temporarily. 
When a different batch is called or the gauge is switched off, the measured readings 
are lost.

Before you start

 The batch for which you want to make the changes is open in the gauge.

To activate/deactivate the save measured reading function 

1.  > Batch Modify > OK > Save Readings > OK
Parameter is activated: 

Parameter is deactivated: 

2. Exit the menu: , the setting has now been made.

The Measurement view shows the  icon to indicate that the measured read-
ing save function has been deactivated.

7.8 Air reference value – automatic/manual acquisition

The air reference value references the zero point determination for the measure-
ment.

 Zero point determination: measurement on the uncoated base material = coat-
ing thickness 0 (normalization, zero)

 Air reference: Measurement in air = coating thickness infinite = saturation = air 
reference value

[   ]
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To achieve a high measurement accuracy, the air reference value has to be mea-
sured on a regular basis.

You can choose between automatic (dynamic) and manual (static) acquisition of the 
air reference value:

Dynamic (default mode)
Dynamic, automatic acquisition of the air value each time the probe is lifted off the 
surface.

Static
Static, no automatic acquisition of the air value each time the probe is lifted off the 
surface. The air reference value has to be measured manually at regular intervals. 
Useful for measurements in small cavities or pipes where the minimum lift off 
distance of the probe cannot be maintained within the cavity/pipe.

Default in Probe
Information about the acquisition method for the air reference value set in the probe 
in the factory.

Before you start

 The batch for which you want to make the changes is open in the gauge.

To change the acquisition method for the air reference value

1.  > Batch Modify > OK > More Settings > OK > Air Reference > OK > set service 
code (159) > OK > set desired acquisition method > OK
Parameter is activated: 

2. Exit the menu: , the setting has now been made.

7.9 Assigning a different calibration to the opened batch

Before you start

 The batch for which you want to make the change is open in the gauge.

[   ]
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To assign a different calibration to the open batch 

►  > Batch Modify > OK > More Settings > OK > Calibration Assign > OK > select 
the desired calibration from the list > OK

A different calibration has now been assigned.

[   ]
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8 Measure

8.1 Notes on measuring

 The information for precision (remaining deviations from precision to mea-
sured reading) and repeatability (repeated standard deviation) applies for the 
ambient and reference piece temperatures at the time of the calibration. The 
values for precision and repeatability may be higher than the values indicated 
in the data sheet if the temperatures during the measurement deviate from the 
ambient and reference piece temperatures during the calibration.

 Rough surfaces: For measurements on rough surfaces, we recommend group-
ing the measured readings into blocks and working with the block mean values 
for further evaluation. This minimizes the measured reading variation in the 
evaluation that follows.

 As a basic rule: If the specified precision is not achieved during the measure-
ment, you must check the calibration recalibrate the probe if necessary.

 If all signal functions in the gauge are activated, the gauge reports the following 
states:

Beeps

• Short beep = measured reading acquisition complete, second beep in addi-
tion if the specification limit is violated

• Long beep = block closure 

Light signals

• Specification limit monitoring not active:
Green = measured reading acquisition successful

• Specification limit monitoring active:
Red = measured reading outside the specification limits, the measured 
reading itself is also displayed in red.

Gauge vibration

• Measured reading acquisition completed, second vibration in addition in 
case of a specification limit violation or block closure
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 For the following measurement situations, we recommend setting the acquisi-
tion of the air reference value to Static:

• Measurements in cavities and pipes if the minimum lift off distance of 
4 x the probe measurement range cannot be respected, 53

• Measurements in Scan measuring mode with a very high number of 
measured reading acquisitions while the surface is being scanned

8.2 Handling the probe

In addition to the calibration, the way in which the probe is placed on the surface is 
also crucial for a precise measurement. Measured reading acquisition via the probe.

Important notes for correctly handling the probe during the measurement

 Always hold the probe at its grip sleeve.
 Always place the probe perpendicular and gently on the surface.
 For the measurement, place the probe quickly on the surface, do not  allow 

the probe to hover over the specimen.
 In default mode, a beep and a green light strip signals that the measured 

reading has been acquired. Only then lift the probe off the surface, lift off 
distance ≥ 4 x the probe measurement range.

 Two-tip probe: For specimens whose base materials have a magnetic 
preferred direction, we recommend determining the measured reading by 
taking the average of two measurements, whereby the probe is to be rotated 
by 90° after the first measurement. Not relevant for the ISOSCOPE® gauge 
models. 

8.3 Before you start

 The measuring area and the probe tip on the probe are clean, free of oil, dust, 
etc. 

 The probe is connected to the gauge.

 The gauge is acclimatized and the battery are sufficiently charged for the up-
coming measurement.

 The desired batch is open in the gauge with the correct measurement settings.
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 In the event of an online data transfer during the measurement, connections 
suitable for Tactile Suite are configured.

During the measurement, you can also perform the following actions 
in the Measurement view

 Delete single/all measured readings or a measured reading lock that has not 
been closed: press the  key.

 View the statistics of the open/last measured reading block: press the BLOCK-
key

 Set block closure manually: BLOCK > CLOSE, available only when automatic 
block formation is deactivated
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8.4 Measuring in single reading measuring mode - procedure

Measuring on flat specimens - single-tip probe
The display screens should be considered only as examples, the gauge default modes are required here 
for the measured reading acquisition, probe D-FN is shown as a typical example of our axial probes
  

Measuring on cylindrical specimens - single-tip probe

The display screens should be considered only as examples, the gauge default modes are required here 
for the measured reading acquisition, probe D-FN is shown as a typical example of our axial probes
   

1. 2.
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Lift off the probe

≥ 4 x probe 
measurement 
rangeCoated specimen

No.

x

Min

n

s

Max

1

121.5

118

5

1.3

123

NF/FE
Batch 001

BLOCK

115
123

125

µm

No.

x

Min

n

s

Max

1

121.5

118

5

1.3

123

NF/FE
Batch 001

BLOCK

115
123

125

µm

1. 2. 3.Position the gauge Measured reading ac-
quisition

Lift off the probe

≥ 4 x probe 
measurement 
range

Coated 
specimen

No.

x

Min

n

s

Max

1

121

118

4

1.2

123

NF/FE
Batch 001

BLOCK

115
120

125

µm

No.

x

Min

n

s

Max

1

121.5

118

5

1.3

123

NF/FE
Batch 001

BLOCK

115
123

125

µm

No.

x

Min

n

s

Max

1

121.5

118

5

1.3

123

NF/FE
Batch 001

BLOCK

115
123

125

µm



50 Measure  DMP30 / DMP40

Measuring on flat specimens - two-tip probe
The display screens should be considered only as examples, the gauge default modes are required here for 
the measured reading acquisition, probe D-F90-2t8 is shown as a typical example of a 2-tip probe
   

Additional measurement with 90° rotated probe when measuring on specimens with 
magnetic preferred direction.

   

Measuring on cylindrical specimens - two-tip probe
The display screens should be considered only as examples, the gauge default modes are required here for 
the measured reading acquisition, probe D-F90-2t8 is shown as a typical example of a 2-tip probe
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8.5 Measuring in free-running measuring mode - procedure

No measured readings are saved!

Measuring on flat specimens
The display screens should be considered only as examples, the gauge default modes are required here for 
the measured reading acquisition, probe D-FN is shown as a typical example of any probe
   

Measuring on cylindrical specimens - single-tip probe
The display screens should be considered only as examples, the gauge default modes are required here for 
the measured reading acquisition, probe D-FN is shown as a typical example of our axial probes
   

Measuring on cylindrical specimens - two-tip probe
The display screens should be considered only as examples, the gauge default modes are required here for 
the measured reading acquisition, probe D-F90-2t8 is shown as a typical example of a 2-tip probe
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8.6 Measuring in scan measuring mode - procedure

Measuring on flat specimens
The display screens should be considered only as examples, the gauge default modes are required here for 
the measured reading acquisition, probe D-FN is shown as a typical example of any probe
 

Measuring on cylindrical specimens - single-tip probe
The display screens should be considered only as examples, the gauge default modes are required here 
for the measured reading acquisition, probe D-FN is shown as a typical example of our axial probes
 

Measuring on cylindrical specimens - two-tip probe
The display screens should be considered only as examples, the gauge default modes are required here for 
the measured reading acquisition, probe D-F90-2t8 is shown as a typical example of a 2-tip probe
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8.7 Measuring with manual recording of the air reference value

If the minimum lift off distance of 4 x the probe measurement range cannot be main-
tained when measuring in cavities and pipes, you can also record the air reference 
value manually at regular intervals.

Before you start

 Air value recording is set to Static, 43

 Refer to the notes on measurement at the beginning of this chapter

 The batch is open, the Measurement view can be seen in the display.

To measure with manual recording of the air reference value

1. Perform your measurements as described in the previous chapters.
We recommend recording the air reference value at regular intervals, e.g. 
between each specimen or after every 10th specimen.

2. Record the air reference value:  > hold the probe in the air > OK > .

The manual recording of the air reference value is now complete.

3. Repeat steps 1. and 2. for subsequent measurements.
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9 Calibration

The term "calibration" is used in this Operator's Manual as a general term for deter-
mining the deviation from a reference value, adjustment and correction: calibration 
of the gauge using calibration standards to adapt the measuring system (gauge and 
probe) to the measuring application at hand. 

The calibration sets the difference between nominal and actual value to zero.

A calibration is a reference measurement during which the material properties and 
geometric shape of the specimen are recorded and stored in a calibration file in the 
connected probe, separate from the batch. During the reference measurement, the 
influencing variables are recorded using an uncoated reference piece and one or two 
calibration standards in order to compensate the influences for future measure-
ments. 

 Uncoated reference piece, the material of which has the same properties as the 
base material of the specimen. Needed for adjustment to the base material (ze-
ro = zero point).

 Calibration standard, available in different versions:

• Calibration foil, plastic foil, hard paper foil or metal foil with a certain thick-
ness, characterized by the nominal value that simulates a coating thickness 
during the calibration process. An adjustment to the corresponding coating 
thickness value is performed for each calibration foil thickness.

• Calibration standard, coated reference piece whose base material and 
coating material have the same properties as the coated specimen and 
whose coating thickness has been determined using the most accurate 
alternative measurement method possible (nominal value of the calibration 
standard).

In order to measure, it is absolutely essential that a calibration suitable for the mea-
suring application has been assigned to the batch. 

The coating thickness measurement is mainly influenced by the following variables:

 Physical properties of the base material of the specimen, such as magnetizabil-
ity (permeability) or electrical conductivity

 Geometric shape of the specimen, such as the thickness of the base material 
or the curvature of the specimen (e.g. cylindrical shape)
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 Position of the measuring position on the specimen, such as distance from the 
edge, hole, platform, or step

 Surface roughness

9.1 Overview of calibration methods

Zero (zero point, calibration step Zero)

This is the simplest type of calibration and is used to calibrate the gauge to a refer-
ence point, the base material, which is called zero here (zero point). The measure-
ment is taken on a reference piece that has the same material and shape as the ac-
tual uncoated specimen to be tested. It consists only of the specimen base material 
(magnetizable (FE) or non-magnetizable (NF), depending on the test method used).

Zero + 1 standard (calibration steps Zero and Std. 1)

A calibration using a calibration standard achieves the best measurement accuracy 
in a narrow measurement range around the stated standard thickness. The calibra-
tion method Zero + 1 standard can be used only in the lower measurement range of 
the gauge.

You can find the values available for the calibration standard in the probe data sheet.

Zero + 2 standards (calibration steps Zero, Std. 1 and Std. 2)

On the one hand, a calibration with 2 calibration standards achieves the best mea-
surement accuracy in the measurement range that is limited by the two calibration 
standard values; on the other hand, however, 2 calibration standards are needed to 
calibrate the upper measurement range of the gauge.

For a calibration with 2 foils, you can find the foil pairings in the probe data sheet.
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9.2 Please observe the following information on calibration/
recalibration

 The reference piece and specimen must have the same base material proper-
ties.

 The positions of the measuring position on the reference piece and on the spec-
imen to be measured must be roughly the same (curvature, distance from the 
edge, hole, platform, and step).

 The information for precision (remaining deviations from precision to mea-
sured reading) and repeatability (repeated standard deviation) applies for the 
ambient and reference piece temperatures at the time of the calibration. The 
values for precision and repeatability may be higher than the values indicated 
in the data sheet if the temperatures during the measurement deviate from the 
ambient and reference piece temperatures during the calibration.

 If measurements are to be performed on both magnetizable (FE) and non-mag-
netizable (NF) base materials, the calibration must be performed using both 
base materials (FE and NF)! This is useful when using a dual probe, such as 
FD13H and D-FN.

 Treat the calibration standards = calibration foils with care. Replace soiled, 
bent, scratched or cracked calibration foils or those with severe indentations. 
In particular foils with thicknesses of less than 50 µm (2 mils) are subject to 
rapid wear. Recommendation: replace the calibration foils after no more than 
100 to 200 measurements!

 Perform the calibration with care! This is the benchmark for the accuracy to 
which the following measurements can be performed. – Measurements can 
never be more accurate than the calibration itself!

Do not use the metal sheet (NF/FE or ISO/NF) supplied with the gauge as a ref-
erence piece! As a rule, the material properties of the metal plate will not cor-
respond to those of your own uncoated specimen/reference piece! The metal 
plate(s) serve only to check the function of the gauge!

Calibration on NF base material (NF = non ferromagnetic base material): the 
difference between the reference piece temperature during the calibration and 
the specimen temperature during the measurement should be minimal. Exces-
sive temperature differences have an adverse effect on the measurement ac-
curacy.
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9.3 Calibration – when is it necessary?

New calibration – when is it necessary?

 When there is a new specimen, the properties for which no calibration has yet 
been created. In this case, you have to record the influencing variables with a 
new calibration in order to compensate for them when measuring.

 For measurements on magnetizable base material (FE), it makes sense to per-
form a calibration with at least 1 calibration standard.

 If the specimen has a very low (e.g. titanium, stainless steel) or very high (e.g. 
copper, silver) electrical conductivity when measured on non-magnetizable 
base material (NF), we recommend performing a calibration with at least 1 cal-
ibration standard here as well.

Recalibration – when is it necessary?

 The measurement does not achieve with the specified degree of precision.

 The check of the current calibration delivers a negative result.

9.4 Recalibration

A recalibration is in effect the repeat of an existing calibration. The calibration data 
are overwritten when a calibration routine is run again.

During the recalibration, you can skip individual calibration steps (Zero or Std. 1/2). 

In the case of rough surfaces, it may be advisable to skip the Zero calibration 
step during the recalibration. Repeat measurements on the rough base mate-
rial do not usually deliver better values. However, if the permeability of the 
specimen base material has changed, you must perform the Zero step on the 
base material with the changed permeability!
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Before you start

 Refer to the notes on calibration, 56

 The probe in which the calibration to be recalibrated is stored is connected to 
the gauge.

 Reference piece and/or calibration foils are ready. You can find the parts you 
need on the calibration info page:  > Calibrations > OK > select name of cali-
bration > OK > Info.

 If the calibration you want to repeat is locked, you need to know the lock code.

To repeat an existing calibration

1. Open the calibration to be repeated:

• Open a calibration from the list:  > Calibrations > OK > select name of cali-
bration > OK > CALIBRATE.

• Open the calibration used in the open batch:  (in the Measurement view).

2. Prompted to set the lock code?

• Yes: Set the lock code and deactivate the lock function, 73
function is deactivated: 

• No: Continue with step 3.

3. Follow the routine and perform the calibration steps (Zero, Std. 1/2). 

a "Calibration step Zero – Procedure", 59 

b "Calibration step Std – procedure", 61

Notes

 If the Shortened course function is activated, the calibration routine switches 
automatically to the next calibration step after every 3 measurements. It is 
not possible to correct/change the specified calibration foil when this func-
tion is activated.

 If you have deactivated the lock function for recalibration, do not forget to 
reactivate the lock function before exiting the calibration menu, 72.

[   ]

[   ]
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9.4.1 Calibration step Zero – Procedure

Measure on the uncoated reference piece.

Required material

 Base material FE: ferromagnetic material = FE = ferrous reference piece from 
customer's own production, without  the coating to be measured; NF/FE dis-
play screen

 Base material NF: non-ferromagnetic, electrically conductive material = NF = 
non-ferrous, electrically conductive reference piece from customer's own pro-
duction, without the coating to be measured; NC/NF display screen

To perform the zero calibration step Zero

1. Perform 5 to 10 measurements on the uncoated reference piece.

The display screens should be considered only as examples, the gauge default modes are required here 
for the measured reading acquisition.

Repeat Steps A to C for the subsequent measurements on the uncoated refer-
ence piece.

2. Finish the calibration step Zero: OK.

3. What would you like to do?

► Finish the calibration: 1 x 
The measuring system is now calibrated to the base material and the part 
geometry (= Zero = zero point), the calibration is finished, the calibration menu 
with the calibration list appears in the display

► Continue the calibration with calibration standard(s): continue with "Calibration 
step Std – procedure", 61

A B CPosition the gauge Measured reading 
acquisition

Lift off the probe

≥ 4 x probe 
measurement 
range

Uncoated 
reference piece

Calibration 003

Zero

x
X -0.0

-0.05 n 3
OK

NF/FE
Calibration 003

Zero

x
X -0.01

-0.05 n 4
OK

NF/FE
Calibration 003

Zero

x
X -0.01

-0.05 n 4
OK

NF/FE
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Display description – Zero calibration step

1 Base material currently being measured 
(example FE)

2 Name of calibration (example)

3 Schematic illustration of the current cali-
bration step

4 Current calibration step

5 Progress display of the calibration steps
(example: calibration step 1 current = cal-
ibration step Zero)

6 Current measured reading (example)

7 Mean value of the measured readings re-
corded up to now in the current calibration step (example)

8 Deletes the last measured reading

9 Battery status display

10 Number of measurements in the current calibration step (example)

11 Continue to next calibration step / exit calibration

NF/FE
Calibration 003

Zero

X

OK

1
2

3

4
5
6
7
8

9

10
11

x
0.0

-0.05 n 3
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9.4.2 Calibration step Std – procedure

Measure on the calibration foil that is directly on top of the uncoated reference piece.

Required material

 Base material, reference piece from customer's own production, without  the 
coating to be measured already used during the Zero calibration step.

 Calibration foils with the desired thicknesses or from the scope of supply for 
the connected probe, the circle on the foil marks the specified measuring area

To perform the zero calibration step Std

1. Place the calibration foil (1/2) (= Std. 1/2) on the uncoated reference piece. 

Only one foil at a time may be on top of the uncoated reference piece!

2. Perform 5 to 10 measurements on the calibration foil (Std. 1).

The display screens should be considered only as examples, the gauge default modes are required here 
for the measured reading acquisition.

Repeat Steps A to C for the subsequent measurements on the uncoated refer-
ence piece.

3. Enter the nominal value of the Std. 1: STD > set nominal value> OK.

Calibration foil (= Std)

Specified measuring 
position

Uncoated
reference piece

A B CPosition the gauge Measured reading 
acquisition

Lift off the probe

≥ 4 x probe 
measurement 
rangeUncoated 

reference piece

Specified mea-
suring position
Calibration foil

Calibration 003

Std 1

x
X 98.9

99.0 n
Std 100

3
OK

NF/FE

STD

Calibration 003

Std 1

x
X 97.9

99.5 n
Std 100

4
OK

NF/FE

STD

Calibration 003

Std 1

x
X 97.9

99.5 n
Std 100

4
OK

NF/FE

STD
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4. Finish the calibration step Std 1: OK.

5. What would you like to do?

► Finish the calibration: 1 x  
The measuring system is now calibrated to the base material (Zero) and the 
part geometry as well as to a reference value (Std 1), the calibration is finished, 
the calibration menu with the calibration list appears in the display

► Continue the calibration with the 2nd calibration standard: OK > repeat steps 1. 
to 4. with the second calibration foil (Std 2)
The measuring system is now calibrated to the base material (Zero) and the 
part geometry as well as to two reference values (Std 1 and Std 2), the calibra-
tion is finished, the calibration menu with the calibration list appears in the 
display.

Display description – Std calibration step

1 Base material currently being measured 
(example FE)

2 Name of calibration (example)

3 Schematic illustration of the current cali-
bration step

4 Current calibration step

5 Progress display of the calibration steps
(example: calibration step 2 current = cal-
ibration step Std 1)

6 Current measured reading (example)

7 Mean value of the measured readings re-
corded up to now in the current calibra-
tion step (example)

8 Deletes the last measured reading

9 Battery status display

10 Number of measurements in the current calibration step (example)

11 Continue to next calibration step / exit calibration

12 Opens the page for entering the nominal value of the foil

NF/FE
Calibration 003

Std 1

X

OK

1
2

3

4
5
6
7
8

9

10
11
12

x
97.1

 96.8
Std
n

100
3

STD
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9.5 Calling up information about the calibration

You can call up information for a selected calibration.

Before you start

 The probe containing the calibration whose information you want to view is 
connected to the gauge.

 If the calibration whose information you want to call up is locked, you need to 
know the lock code.

To call up information about a calibration

1. Select the calibration whose information you want to call up: > Calibrations > 
OK > select name of the calibration > OK.

2. Prompted to set the lock code?

• Yes: Set the lock code: 

• No: Continue with step 3.

3. Open the information page: Info > OK. 

4. Exit the information page: .

Description of parameters on page Info

Only the standards, with their values, that were used for the calibration are displayed 
on the information page next to the date and time.

Std 1 (NF/FE): 100 μm (example)
Calibration on ferrous base material (FE), indication of the foil thickness (nominal 
value) for the Std. 1, used for this calibration.

Std 2 (NF/FE): 527 μm (example)
Calibration on ferrous base material (FE), indication of the foil thickness (nominal 
value) for foil 2 used for this calibration. 

Std 1 (NC/NF): 89.9 μm (example)
Calibration on non-magnetizable base material (NF), indication of the foil thickness 
(nominal value) for foil 1 used for this calibration.

[   ]
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Std 2 (NC/NF): 201 μm (example)
Calibration on non-magnetizable base material (NF), indication of the foil thickness 
(nominal value) for foil 2 used for this calibration. 

Date / Time:
13.04.2022 10:23 (example): storage time of calibration

9.6 Activating/deactivating semi-automatic calibration routine

The Shortened course function activates a semi-automatic calibration routine for the 
selected calibration. If the Shortened course function is activated, the calibration rou-
tine switches automatically to the next calibration step after every 3 measurements. 
The next calibration step is signaled only through the display of the required stan-
dard value. It is not possible to correct/change the specified calibration standard 
when this function is activated.

Before you start

 The probe is connected to the gauge containing the calibration for which you 
want to activate/deactivate the semi-automatic calibration routine.

 If the calibration for which you want to activate or deactivate this function is 
locked, you need to know the lock code.

To activate/deactivate the function for a calibration

1. Select the calibration for which you want to activate/deactivate the function:  
> Calibrations > OK > select name of calibration > OK.

2. Prompted to set the lock code?

• Yes: Set the lock code and deactivate the lock function, 73
function is deactivated: 

• No: Continue with step 3.

3. Activate/deactivate the function: Shortened course > OK.

Function is activated: 
At the next recalibration, the calibration routine will be performed semi-auto-
matically.

Function is deactivated: 

[   ]
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4. Did you deactivate the lock function in step 2.?

• Yes: Reactivate the lock function, 72
function is activated: 

• No: Continue with step 5.

5. Exit the menu: , the function is now activated/deactivated.

9.7 Calibration - reset

You can reset a calibration and delete all the correction values (coating thickness) of 
the selected calibration. The function deletes all parameters measured in the Std 
calibration steps. The entered standard nominal values and the measurements of 
the Zero calibration step are retained.

Before you start

 The probe is connected to the gauge containing the calibration you want to re-
set.

 If the calibration for which you want to activate or deactivate this function is 
locked, you need to know the lock code.

To reset the selected calibration

1. Select the calibration you want to reset:  > Calibrations > OK > select name of 
calibration > OK.

2. Prompted to set the lock code?

• Yes: Set the lock code and deactivate the lock function, 73.
Function is activated: 

• No: Continue with step 3.

3. Start the function: Reset > OK.

4. Confirm the prompt asking whether you want to proceed with the Reset: 

5. Did you deactivate the lock function in step 2.?

• Yes: Reactivate the lock function, 72
function is activated: 

• No: Continue with step 6.

6. Exit the menu: , the calibration has now been reset.

[   ]
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9.8 Creating new calibration

In the following cases, you have to record the influencing variables with a new cali-
bration in order to compensate for them when measuring.

 When there is a new specimen, the material properties, geometry and coating 
thickness range for which no calibration has yet been created. 

 You have determined during test measurements that none of the listed calibra-
tions is suitable for the specimen at hand.

Before you start

 Refer to the notes on calibration, 56.

 The probe with which the new calibration is to be performed is connected to the 
gauge.

 Reference piece and/or calibration standards (calibration foils) are ready. 
The parts you need depends on the specifications in the directives/standards 
or the measurement accuracy required. 

Overview of calibration methods, page 55

To create a new calibration

1. Open the calibration menu New:  > Calibrations > OK > New > OK.

2. Follow the routine and perform the desired calibration steps (Zero, Std. 1/2). 

a "Calibration step Zero – Procedure", 59 

b "Calibration step Std – procedure", 61

This completes the creation process for a new calibration. The calibration is stored 
in the connected probe or in the DMP-F probe adapter under the probe identifier of 
the connected probe.

Keep in mind that many calibrations involving different calibration methods for 
different base materials can be stored in the probe/DMP-F probe adapter. A 
unique name makes it easier to select and assign the desired calibration to a 
batch. 

Calibration - assigning/changing names, page 67

[   ]
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9.9 Calibration - assigning/changing names

Assign a unique name to the calibration (calibration method, material designation, 
batch no., …), example: Z+1F EN AW 6082 or Z EN AW 6082.

Keep in mind that many calibrations involving different calibration methods for 
different base materials can be stored in the probe/DMP-F probe adapter. A 
unique name makes it easier to select and assign the desired calibration to a 
batch.

Before you start

 The probe is connected to the gauge (via DMP-F probe adapter) containing the 
calibration whose name you want to change.

 If the calibration whose name you want to change is locked, you need to know 
the lock code.

To change the name of a calibration

1. Select the calibration whose name you want to change:  > Calibrations > OK > 
select name of calibration > OK.

2. Prompted to set the lock code?

• Yes: Set the lock code and deactivate the lock function, 73.
Function is deactivated: 

• No: Continue with step 3.

3. Open the input menu: Rename > OK.

4. Change the name:

• Move cursor using the  and OK keys

• Select characters using the  and OK keys

• Delete characters by selecting the space ( )

5. Exit the input menu:

a Move the cursor to the far right using the OK key. The character  appears 
at the right edge of the display.

b Press OK to close the input menu.

[   ]
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6. Did you deactivate the lock function in step 2.?

• Yes: Reactivate the lock function: 72.
Function is activated: 

• No: Continue with step 7.

7. Exit the calibration menu: , the name has now been changed.

9.10 Checking the precision of a calibration

The Check Calibration function checks during a control measurement whether the 
mean value of the control measurement matches the nominal value of the used foil 
within the measurement uncertainty (in accordance with ISO/IEC Guide 98-3).

Important to know

 The Check Calibration function allows you to check the calibration state of the 
selected calibration and the measurement accuracy of the measurement sys-
tem. The result of the check applies only to the calibration selected.

 The check must be performed under the same conditions applied for the cali-
bration procedure, at the same temperature, using the same base material for 
example.

 The precision of the calibration is limited by the measurement uncertainty of 
the calibration standard (calibration foil). The measurement uncertainty of the 
calibration must not be smaller than the measurement uncertainty of the cali-
bration standard used. To improve the calibration precision, you must use cal-
ibration standards with smaller measurement uncertainties for the calibration 
procedure.

 The determined measurement uncertainty applies only to a small range around 
the nominal value of the foil for which the control measurement was per-
formed.

If you wish to determine the measurement uncertainty for a measurement 
range, perform control measurements on two foils that limit the measurement 
range. You can determine the measurement uncertainty for this measurement 
range through a linear interpolation of the two measurement uncertainties of 
the control measurements on the two foils.
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Before you start

 The test parameters for the selected calibration are defined. 
Defining the test settings, 71.

 The probe is connected to the gauge containing the calibration you want to 
check.

 Reference piece and a calibration standard (calibration foil) already used for 
the calibration procedure are ready. You can find the parts you need on the cal-
ibration info page:  > Calibrations > OK > select name of calibration > OK > Info.

 Before the control measurement is carried out, the gauge with connected probe 
must have been switched on for at least 10 minutes! This is necessary to en-
sure that all gauge components have reached their operating temperature. 
Otherwise, slightly increased measurement errors can occur!

 If the calibration you want to check is locked, you need to know the lock code.

To check the desired calibration

1. Select the calibration whose measurement accuracy you want to check:  > 
Calibrations > OK > select name of calibration > OK.

2. Prompted to set the lock code?

• Yes: Set the lock code and deactivate the lock function, 73.
Function is deactivated: 

• No: Continue with step 3.

3. Start the function: Check Calibration > OK. 

4. Place the foil for the control measurement on the base material.

5. Take a few control measurements on the foil. We recommend taking 10 
measurements. The circle on the foil marks the specified measurement area.

Description of the displayed variables on the Check Calibration page:

• Val.: Nominal value of the calibration standard (calibration foil), set in the 
Def. Cal. Check menu.

• Δabs: Tolerance/uncertainty of the foil, set in the Def. Cal. Check menu.

• Nmin: Minimum number of required measurements

• : Arithmetic mean value, determined from the measurements taken; red 
values are outside the tolerance limits 

[   ]
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• s: Standard deviation, determined from the measurements taken; red 
values are outside the tolerance limits

• n: Number of measurements taken

6. Start the check: OK

7. An information page displays the following result:

Calibration is OK

The mean value of the control measurement matches the nominal value 
(= reference value) of the used calibration standard (calibration foil) within the 
measurement uncertainty (in accordance with ISO/IEC Guide 98-3). This means 
that the difference between the mean value and the nominal value cannot be 
distinguished from the specified measurement uncertainty of the calibration 
standard. The measurement accuracy for the open batch is OK for the calibra-
tion standard used and cannot be further improved by this calibration standard.

Calibration is NOT OK

The measured mean value of the control measurement has an excessive devi-
ation from the nominal value of the calibration standard (calibration foil). First, 
perform a recalibration. Be sure to use standard values appropriate for the 
selected calibration method.

  The data sheet of the probe provides the values available and suitable 
for the calibration standard(s).

 Also refer to the note on "Precision" on page 68.

8. Finish the check: OK

9. Did you deactivate the lock function in step 2.?

• Yes: Reactivate the lock function, 72.
Function is activated: 

• No: Continue with step 10.

10. Exit the calibration menu: , the calibration check has finished.

Tips

 If the calibration check fails even after recalibration, perform a new recali-
bration only with calibration step Zero, skipping the other calibration steps via 

.
 Reset the calibration using the Reset function, 65
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9.11 Defining the test criteria for the calibration check

You can perform a control measurement to check the precision of a selected calibra-
tion. The check is based on the measurement uncertainty (tolerance) specified for 
the calibration standard (calibration foil) used during the control measurement. To 
be able to check a calibration, you have to enter for this calibration the measurement 
uncertainty or tolerance for the calibration standard you want to use for the check 
(control measurement).

Before you start

 You know the tolerance or the measurement uncertainty (k=2) for the calibra-
tion standard to be used later during the control measurement. These values 
can be noted in a certificate or on the calibration standard itself.

 The probe is connected to the gauge containing the calibration whose test cri-
teria you want to define.

 Please also refer to section "Important to know", 68.

 If the calibration whose test parameters you want to enter for the check is 
locked, you need to know the lock code.

To define the test criteria

1. Select the calibration for which you want to enter the test criteria:  > Calibra-
tions > OK > select name of calibration > OK.

2. Prompted to set the lock code?

• Yes: Set the lock code and deactivate the lock function, 73.
Function is deactivated: 

• No: Continue with step 3.

3. Open the settings menu: Define Cal. Check > OK.

4. Select the format in which you have the uncertainty/tolerance values for the 
calibration standard you intend to use for the check (control measurement) 
later: select desired tolerance value > OK.
Parameter is activated: 

Parameter selection:

• No: Check function deactivated

• Abs. Tol., example: ± 1.5 μm

[   ]
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• Rel. Tol., percentage value, example: ± 1.25 %

• Uncertainty, example: expanded measurement uncertainty for an expansion 
factor k=2: ± 4.5 μm

5. Set the nominal value and the tolerance/measurement uncertainty for the cali-
bration standard you intend to use for the check (control measurement) later: 
Reference Value > OK > set value > OK.

Repeat Step 5. for the tolerance/uncertainty.

When entering, pay attention to the unit of measurement. Enter the values 
in the unit of measurement set for the currently open batch.

Input parameters:

• Reference Value: Nominal value of the calibration standard

• Abs. Tol./Rel. Tol. or U(k=2): Tolerance/measurement uncertainty value of 
the calibration standard

6. Did you deactivate the lock function in step 2.?

• Yes: Reactivate the lock function, 72.
Function is activated: 

• No: Continue with step 7.

7. Exit the menu: , the test criteria are now defined.

9.12 Lock calibration

The Lock Calibration function locks the opening and the calibration routine of the se-
lected calibration. You can unlock the menu for the locked calibration and calibration 
routine only by entering the lock code. This lock function can be used only if a lock 
code is defined in the gauge.

Before you start

 The probe is connected to the gauge containing the calibration you want to lock.

 A lock code is defined in the gauge, 94

To lock a calibration

1. Select the calibration you want to lock:  > Calibrations > OK > select name of 
calibration > OK.

[   ]
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2. Activate the lock function: Lock Calibration > OK.

Function is activated: 

3. Exit the menu: , the locking process has finished.

To access the menu and the calibration routine of the locked calibration, you 
now need to enter the lock code.

9.13 Calibration – deactivating lock

The Lock Calibration function blocks access to the menu and to the calibration routine 
of the selected calibration. You can deactivate the lock function for the menu and the 
calibration routine of the locked calibration only by entering the lock code.

Before you start

 The probe is connected to the gauge containing the calibration whose lock you 
want to deactivate.

 To deactivate the lock function of a calibration, you need to know the lock code.

To deactivate the lock of selected calibration

1. Select the calibration whose lock you want to deactivate:  > Calibrations > OK 
> select name of calibration > OK.

2. Deactivate the lock:

a Set the lock code: set lock code > OK.

b Deactivate the lock function: Lock Calibration > OK.
Function is deactivated: 

The unlocking process is finished, you now have free access to the functions in the 
menu of the selected calibration.

Before exiting the calibration, do not forget to reactivate the lock function for 
the menu of the selected calibration, 72.

[   ]
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9.14 Deleting a calibration

You can delete individual calibrations from the memory of the probe/DMP-F probe 
adapter.

Before you start

 The probe is connected to the gauge containing the memory from which you 
want to delete a calibration.

 If the calibration you want to delete is locked, you need to know the lock code.

To delete a calibration

1. Select the calibration you want to delete:  > Calibrations > OK > select name 
of calibration > OK.

2. Prompted to set the lock code?

• Yes: Set the lock code and deactivate the lock function, 73.
Function is deactivated: 

• No: Continue with step 3.

3. Select the delete function: Delete > OK.

4. Start the delete process: .

5. Exit the menu: , the delete process has finished.

9.15 Deleting all calibrations

You can delete al l  your calibrations from the memory of the connected probe. This 
function deletes all the calibration files and all their data! 

DMP-F probe adapter: You can use this function to delete all calibrations from the 
DMP-F probe adapter that were created using the connected probe. Useful when an 
existing probe is to be replaced by a new one. In this case, the calibrations of the old 
(e.g. defective) probe are no longer needed, so they can be deleted and do not unnec-
essarily take up memory space in the DMP-F probe adapter.

ATTENTION

 Please note that a measurement without a calibration is not possible!
 You must assign a new calibration to each batch already created!
 Using this function you also delete the locked calibrations in the probe/DMP-

F probe adapter!

[   ]
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Before you start

 The probe is connected to the gauge containing the memory from which you 
want to delete al l  calibrations.

To delete al l  calibrations from the memory of the connected probe

1. Call up the delete function:  > Gauge Settings > OK > Probe - Menu > OK > Delete 
all calibrations > OK.

2. Start the delete process: .

3. Exit the menu: , the delete process has finished.

The delete process has finished, the calibration memory of the probe is now empty.

What you should do next

 Create new calibration(s), see page 66
 Assign the new calibrations to the batches, page 44

[   ]
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10 Evaluation

The gauge provides you with the mathematical calculations, complex and extensive 
at times, needed for statistical evaluation of the measured readings from the opened 
batch and the measurement blocks when automatic block formation is switched on. 
The evaluation refreshes continuously in the background during the measurement.

The statistical characteristic variables of the open batch are displayed in the Statis-
tics menu. If automatic block formation is activated for the open batch, you can also 
display the statistical evaluation for each measured reading block. Either the individ-
ual measurements or the block average values are considered and displayed as 
measured readings in the statistical evaluation.

10.1 Batch statistics

 Display statistical characteristic variables for all 
measured readings of the open batch:  > Statis-
tics > OK.

 Display histogram for all measured readings of the  
open batch (possible from 5 measured readings): 

 > Statistics > OK >  > Batch Charts > OK > His-
togram > OK. 

If no measurement data appear for the class divi-
sion, the display refers to the entire measurement 
range of the connected probe.

Description of the characteristic variables, see 
page 15

Example of batch statistics

NF/FE
Batch Statistics

n 9 x 274.4

s 2.67 R 8.5

V[%]  1.0 Min 271

Max 280 <LSL 0

>USL 0

BLOCK

[   ]
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10.2 Block statistics

 Display statistical characteristic variables for each 
measured reading block:  > Statistics > OK > 
BLOCK.

: Scroll through the individual block statistics 
(block no. 1 to x)

Description of the characteristic variables, see 
page 15

10.3 Individual measured readings

 Display the individual measured readings of the se-
lected measured reading block:  > Statistics > OK 
> BLOCK >  > Block Readings > OK. 

: Scroll through the individual measured readings of the selected measured 
reading block (possible from block size > 6).

Example: Block statistics of 
measured reading block 
number 4

NF/FE
Block Statistics

No. 4 x 127.7

n 3 s 2.45

R  4.5 V[%] 1.9

Min 125 Max 129

<LSL 0 >USL 0

[   ]
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11 Data transfer

Data export is possible only from the gauge to the Tactile Suite software program. 
Individual measured readings, batch statistics, block statistics and the entire batch 
can be exported to Tactile Suite. 

Tactile Suite is a software solution for evaluating measured readings, creating in-
spection reports, archiving measured readings, inspection reports and batch files, 
and for exporting measured readings in CSV format. 

You can download the Tactile Suite program free of charge from the Fischer down-
load page.

Information on how to use the Tactile Suite software program can be found in the 
corresponding Operator's Manual ( Tactile Suite).

Fischer download page: https://docs.helmut-fischer.com/uum 

Notes on data transfer

 Calibration data cannot be transferred.
 Interfaces: USB and Fischer-Bluetooth® stick
 You can write the measured readings directly into an Excel spreadsheet 

online via Tactile Suite during the measurement.

https://docs.helmut-fischer.com/uum
https://docs.helmut-fischer.com/uum
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11.1 Data transfer via USB

Before you start

 The Tactile Suite software program is installed on the PC and opened.

 The gauge is switched off.

 The USB cable from the scope of supply is ready.

For the data transfer, use the USB cable from the scope of supply or any other 
commercially available USB cable with a C/A-type plug; maximum usable cable 
length: 3 m (118.1 ")

To transfer data to Tactile Suite via USB

1. Connect the gauge to your PC. 
Use the USB connection on the top of the gauge.

2. Switch on the gauge: 

The gauge is automatically detected and displayed in Tactile Suite in the menu on the 
left. All data from the gauge are synchronized with Tactile Suite. 

1. 2.

[   ]
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11.2 Data transfer via Bluetooth

To transfer data using Bluetooth®, you need the special Fischer-Bluetooth stick, in-
cluded in the scope of supply.

Before you start

 The Tactile Suite software program is installed on the PC.

 The Fischer-Bluetooth stick from the scope of supply is ready.

 The battery in the gauge is charged, 31.

 The automatic gauge shutdown function is deactivated, 92.

ATTENTION – interruption to data transfer

Please note that switching off the gauge interrupts data transfer!

To transfer data to Tactile Suite via Bluetooth

1. Insert the Fischer-Bluetooth stick into the gauge: 

2. Switch on the gauge: 

1. 2. 3. 4.
Fischer-
Bluetooth 
stick

7.5. 6.

[   ]
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3. Activate the Fischer-Bluetooth stick:  > Gauge Settings > OK > Bluetooth > OK.
function is activated: 
A white Bluetooth icon appears in the uppermost header to indicate that the 
Fischer-Bluetooth stick is activated.

4. Exit the menu: , the settings in the gauge are now made.

5. PC: Establish the Bluetooth connection to your PC. Add the gauge (Helmut 
Fischer GmbH BT Device) as a new gauge or refresh the connection.
Gauge: A blue Bluetooth icon appears in the uppermost header to indicate that 
a Bluetooth connection has been established.

6. PC: Open Tactile Suite on your PC.
The gauge is automatically detected and displayed in Tactile Suite in the menu 
on the left. All data from the gauge are synchronized with Tactile Suite.

The connection settings are now made.

[   ]
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12 Batch settings

For the open batch, you can make settings that do not directly affect the measure-
ment, such as changing the Measurement view, the max. number of decimal places 
for the displayed values or calling up the batch information.

12.1 Calling up information about the open batch

You can call up information about the open batch. All settings, assigned calibration 
and probe information used to create this batch are listed on an information page.

Before you start

 The batch for which you want to view the information is open in the gauge.

To call up information about the open batch

1.  > Batch Modify > OK > Batch Info > OK

2. Exit the information page: 

Description of parameters on page Batch Info

Batch Name
Name of the batch file.

Probe Name
Name of the probe used to create this batch.

Probe Serial Number
Serial number of the probe used to create this batch.

Calibration
Name of the calibration assigned to this batch. 

Limits [µm]
Information on specification limit monitoring: off or indication of the specification 
limits (LSL and USL)/ the specification limit (LSL).

[   ]
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Measurement View
Type of Measurement view set for this batch (Simple, Statistics).

Meas. unit
µm (example)

Block Size
Number of measured readings collected in a block.

Offset
Information about the offset: off or set offset value.

Measure Mode
Information about the set measuring mode: Single Readings, Free Running or Scan 
with the set scan parameters

Values rounding
Information about the resolution of the displayed values: number of decimal places 
used to display the measured reading and the statistical values.

Save Readings
Information indicating whether this function is activated or deactivated for this batch.

Air Reference
Information indicating how the probe acquires the air value for this batch.

12.2 Changing the unit of measurement for the batch

You can change the unit of measurement for the open batch, as well as its block and 
batch statistics.

 block andBefore you start

 The batch for which you want to make the changes is open in the gauge.

To change the unit of measurement

1.  > Batch Modify > OK > Meas. unit > OK > select desired unit of measurement 
> OK
Unit of measurement is activated: 

2. Have you selected the Own Unit unit of measurement?

• No: Continue with step 3.

[   ]
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• Yes: Set the desired variables for your own unit of measurement:

a : Select the parameter Own Multiplier and set the multiplier related to 
the unit of measurement µm.

b : Select the parameter Own Unit and assign a name for the unit of 
measurement.

Change the name:

• Move cursor using the  and OK keys

• Select characters using the  and OK keys

• Delete characters by selecting the space ( )

Exit the dialog page Rename:

a Use the OK key to move the cursor to the far right until the character 
 appears at the right edge of the display.

b Exit the dialog page: OK.

3. Exit the menu: , the settings are now made.

The previous measured readings and statistical evaluations are converted and dis-
played according to the newly set unit of measurement.
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12.3 Selecting the Measurement view for the batch

You can display various items of additional information for the open batch. You can 
choose between two Measurement views.

Before you start

 The batch for which you want to make the changes is open in the gauge.

To select a Measurement view

1.  > Batch Modify > OK > Views Settings > OK > Measurement View > OK > select 
desired Measurement view > OK
Measurement view is activated: 

The display screens below should be considered only as examples; batch 001 has set specifica-
tion limits.

   

NF/FE
Batch 001

BLOCK

47.3 µm
i44.5

i49.0

NF/FE
Batch 001

No. 1 n 10

46.8 s 1.81

Min 44.9 Max 48.5

x

BLOCK

47.3 µm
i44.5

i49.0

Measurement view 
Simple

Measurement view 
Statistics (default mode)

Only the current measured 
reading is displayed.

In addition to the current 
measured reading, a mea-
sured reading statistic is 
shown in a table.

[   ]



86 Batch settings  DMP30 / DMP40

2. Have you selected the Statistics Measurement view?

• Yes: Select the desired characteristic variables:

a  > OK.
Characteristic variable is switched on: 
A maximum of 6 characteristic variables can be displayed in the 
Measurement view Statistics, description of characteristic variables, 

15.

b Continue with step 3.

• No: Continue with step 3.

3. Exit the menu: , the settings are now made.

The measured readings (and statistical evaluations) are displayed according to the 
newly set Measurement view.

12.4 Selecting characteristic variables for the statistical displays

For the open batch, you can select the statistical characteristic variables that are to 
be displayed on the evaluation pages Batch Statistics and Block Statistics.

Before you start

 The batch for which you want to make the changes is open in the gauge.

To select the statistical characteristic variables

1.  > Batch Modify > OK > Views Settings > OK > Batch Statistics View or Block 
Statistics View > OK

2. Select the desired characteristic variables:  > OK.

Characteristic variable is activated: 

Description of the characteristic variables, 15

3. Exit the menu: , the settings are now made.

[   ]
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12.5 Setting the decimal places for the display values

For the open batch, you can set the number of decimal places for displaying the mea-
sured reading and for the values of the statistical characteristic variables both in the 
Measurement view and in the statistical displays.

Before you start

 The batch for which you want to make the changes is open in the gauge.

To set the decimal places for the display values

1.  > Batch Modify > OK > More Settings > OK > Values rounding > OK > select 
desired max. number of decimal places > OK
Parameter is selected: 

Parameter selection:

• Low: maximum 1 decimal place is displayed
0.9 / 9.9 / 99 / 999 / 9999

• Medium: maximum 2 decimal places are displayed
0.99 / 9.9 / 99.9 / 999 / 9999

• High: maximum 3 decimal places are displayed
0.999 / 9.99 / 99.99 / 999.9 / 9999

• Navsea: 
measured readings up to 254 μm (10 mils) are displayed with 1 decimal 
place, 0.9 / 9.9 / 99.9 / 253.9

Measured readings from 254 μm (10 mils) are displayed as an integer, 254 
/ 999 / 9999

2. Exit the menu: , the settings are now made.

[   ]
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13 Batch management

You can rename, copy and delete batch files.

13.1 Assigning/changing batch names

You can rename every batch.

Keep in mind that many batch files are stored in the gauge. A unique name 
makes the selection process easier.

To change the name of a batch

1. Call up the Rename function:  > Batches > OK > select desired batch > OK > 
Rename > OK.

2. Change the name:

• Move cursor using the  and OK keys

• Select characters using the  and OK keys

• Delete characters by selecting the space ( )

3. 3. Exit the dialog page Rename:

a Use the OK key to move the cursor to the far right until the character  
appears at the right edge of the display.

b Exit the dialog page: OK.

The batch name has now been renamed.

13.2 Copying a batch

You can find all the information you need to copy a batch in section "Creating a 
new batch by copying", page 38.

[   ]
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13.3 Deleting a batch

You can delete individual batch files. The selected batch is deleted together with the 
measured readings.

The opened batch cannot  be deleted.

To delete a batch

1.  > Batches > OK > select desired batch > OK > Batches > OK

2. Start the delete process: .

3. Exit the menu: , the delete process has finished.

[   ]
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14 Gauge settings

The display language, date, and time, for example, are general gauge settings and 
apply to all batches.

In addition to the general gauge settings, you can also retrieve information about the 
gauge software, copyright, etc. from the Gauge Settings menu.

14.1 Setting the language

You can set the display language for the gauge.

To select the language

1.  > Gauge Settings > OK > Language > OK > select desired language > OK
Parameter is activated: 

2. Exit the menu: , the language has now been set.

14.2 Display settings

You can activate and deactivate the automatic flip display view according to the 
gauge position, and also adjust the display brightness.

To change the display settings

1.  > Gauge Settings > OK > Display Settings > OK

• Activate/deactivate flip function for the display: Flip Display > OK.

Parameter is activated: 

• Set display brightness: Brightness > OK > set desired brightness value > OK

2. Exit the menu: , the settings are now made.

[   ]
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14.3 Signal settings – visual and audible signals

You can activate and deactivate the sound and light signals, as well as the gauge vi-
bration function for measured reading acquisition and specification limit violations.

To activate/deactivate the signals

1.  > Gauge Settings > OK > Signal Settings > OK

2. Select the desired signal function:  > OK.

Function is activated: 

• Parameter Light intensity, set the desired brightness value:  > OK

The higher the set value, the higher the luminosity.

3. Repeat step 2. for more menu functions.

4. Exit the menu: , the settings are now made.

Signals

The sound and light signals listed in the table are output in succession, if necessary, 
e.g. at the last measured reading of a block (block closure): 1 short beep followed by 
a long beep and the light band lights up in green, then in yellow.

Beeps/
beep

Visual signal
probe + gauge

Meaning

1 x short 1 x green Measured reading acquisition, measured 
reading is within the specification limits/
above the specification limit when specifi-
cation limit monitoring is activated

1 x short + 1 x long 2 x red Measured reading is outside the specifica-
tion limits/below the specification limit 
when specification limit monitoring is acti-
vated

1 x long 1 x yellow Block closure, when automatic block for-
mation is activated

[   ]
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14.4 Energy saving

To prolong the battery life as far as possible, the gauge offers automatic shutdown 
and display dimming as energy-saving functions.

To change the shutdown and dimming times, and also the dimming 
strength

1.  > Gauge Settings > OK > Energy Savings > OK

2. Select the desired function:  > OK.

3. Set the desired time value/dimming strength:  > OK

Shutdown time 0 min: Function deactivated, there is no automatic gauge 
switch-off or display dimming

max. shutdown time: 1000 min.

4. Repeat steps 2. and 3. for more menu settings.

5. Exit the menu: , the settings are now made.

Description of the energy-saving functions

 Switch off after
Automatic gauge shutdown after a preset period of time without any action (key 
confirmation or measured reading acquisition)

 Switch off (USB)
Automatic gauge shutdown after a preset period of time without any data 
transfer via USB interface

 Dim display after
The display brightness is automatically dimmed to the specified brightness val-
ue (Dimming Ratio) after a preset period of time.

14.5 Activating/deactivating the Bluetooth function

To transfer data using Bluetooth®, you need a special Fischer Bluetooth stick. This is 
included in the gauge's scope of supply. To activate Bluetooth, the function must be 
activated in the gauge.

[   ]
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Further information on establishing a Bluetooth connection and transferring 
data can be found on page 80.

To activate/deactivate the Bluetooth function

1.  > Gauge Settings > OK > Bluetooth > OK

2. Activate the Bluetooth function: OK.
Function is enabled: 
A white Bluetooth icon in the uppermost header indicates that the Bluetooth 
function is activated. For a description of more icon colors, see 10.

3. Exit the menu: , the setting has now been made.

14.6 Date & time

You can set the date and time as well as the date and time format for the gauge.

To set the date & time

1.  > Gauge Settings > OK > Date & Time > OK

2. Select the desired parameter:  > OK.

3. Set the desired time or date or select the desired format:

Date and time setting

• Move cursor using the OK and  keys

• Number selection using the  keys

Format selection:  > OK

Format is selected: 

4. Repeat steps 2. and 3. for more menu settings.

5. Exit the menu: , the settings are now made.

[   ]
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14.7 Default settings for unit of measurement and decimal places

You set defaults in the gauge for the unit of measurement and the maximum number 
of decimal places. All newly created batches are automatically assigned this these 
default variables (Preset Unit and Preset rounding).

To change the unit of measurement

1.  > Gauge Settings > OK > More Settings > Preset Unit > OK > select desired unit 
of measurement > OK
Unit of measurement is activated: 

2. Exit the menu: , the settings are now made.

To set the number of decimal places for the display values

1.  > Gauge Settings > OK > More Settings > OK > Preset rounding > OK > select 
desired max. number of decimal places > OK
Parameter is selected: 

Parameter selection:

• Low: maximum 1 decimal place is displayed 0.9 / 9.9 / 99 / 999 / 9999

• Medium: maximum 2 decimal places are displayed 0.99 / 9.9 / 99.9 / 999 / 
9999

• High: maximum 3 decimal places are displayed 0.999 / 9.99 / 99.99 / 999.9 
/ 9999

• Navsea: measured readings up to 254 μm (10 mils) are displayed with 1 
decimal place, 0.9 / 9.9 / 99.9 / 253.9

2. Exit the menu: , the settings are now made.

14.8 Activating/deactivating lock code

Use the lock code to activate/deactivate the lock function (Lock Calibration) for select-
ed calibrations.

[   ]
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To activate the lock code

1.  > Gauge Settings > OK > More Settings > Define Lock Code > OK > set desired 
lock code > OK

2. Confirm the activation information: OK

3. Exit the menu: , the lock code has now been activated.

To deactivate the lock code

You must know the lock code to deactivate it.

1.  > Gauge Settings > OK > More Settings > Delete Lock Code > OK > set lock code 
> OK

2. Confirm the deactivation information: OK

3. Exit the menu: , the lock code has now been deactivated.

14.9 Reducing electromagnetic interference on the measurement

When the magnetic induction test method is used, the electromagnetic interference 
radiation from the local mains voltage can influence the coating thickness measure-
ment. Such interference radiation can occur close to transformers, for example. 
When the local mains frequency is selected, the gauge compensates for this inter-
ference.

Not relevant for the ISOSCOPE® gauge models

To set the frequency of the local voltage supply

1.  > Gauge Settings > OK > Probe - Menu > OK > Set Power Line Frequency > OK 
> select local mains frequency > OK
Parameter is selected: 

2. Exit the menu: , the settings are now made.

[   ]
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15 Service

15.1 Probe – count rate recording/display

For error analysis, it can be helpful to view the count rates delivered directly from 
the probe. Our experts can use the count rates shown in the display to draw conclu-
sions about the status of the probe, for example, and propose potential solutions.

The count rates are measured and displayed in a service area, and this does not af-
fect the batches created in the gauge.

You can also export the count rates, although only during the measurement (online), 
to an Excel® table via USB and Tactile Suite.

Before you start

 The probe with count rates to be checked is connected to the gauge.

 For a data transfer to Excel®, the software programs Tactile Suite and MS Excel 
are installed on the PC and opened. The USB cable from the scope of supply is 
ready.

For the data transfer, use the USB cable from the scope of supply or any other 
commercially available USB cable with a C/A-type plug; maximum usable cable 
length: 3 m (118.1 ")

The link for downloading Tactile Suite and additional information can be 
found on page 78.

To display/export the count rates 

1.  > Gauge Settings > OK > Probe - Menu > OK > Probe Raw Values > OK > Coun-
trate - Check > OK

2. Carry out one of the following measuring methods:

• Individual measurements

• Continuous count rate recording: 
Place the gauge on the surface and press RUN; the gauge displays the 
continuously recorded count rates.

[   ]
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Finish continuous count rate recording: STOP

TH
Switches to coating thickness display in the count rate Measurement view 
(unit of measurement set as in the open batch)

XN
Switches to count rate display in the count rate Measurement display

3. Exit the menu: , the settings are now made.

15.2 Gauge cleaning

Switch off the gauge before cleaning it!

Cleaning the gauge

► Simply wipe away normal soiling, such as dust, with a damp cloth.

► Wipe away oily deposits with a dry cloth and then clean the spots with plastic 
cleaner or household detergent.

► Remove paint and lacquer using a solvent. Use solvents such as acetone, 
methyl ethyl ketone, turpentine oil, or xylene to clean the gauge.

ATTENTION – Damage to the gauge/probe

 Do not clean the gauge/probe under running water!
 IP64 ≠ water-proof, gauges in protection class IP64 are resistant only to 

splash water. They are not waterproof and cannot withstand constant water 
pressure!

 Scratches on the display
Cleaning the display with a dry cloth can scratch the display.
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16 Gauge information

All gauge information, such as information about its status, firmware and legal infor-
mation can be found in the Gauge Settings menu.

To call up the information page

1.  > Gauge Settings > OK > About > OK

: Scroll, display next page

2. Exit the information page: 

[   ]
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